1 DAS ERSTE
PROJEKT

Du mdchtest natiirlich gleich hier an Ort und Stelle dein erstes Spiel erstellen. Dar-
aus wird nichts. Noch nicht. Als Erstes brauchst du Geduld. Und Ausdauer. Hier
starten wir aber schon die Maschine, mit der wir spater einiges zaubern werden,
das sich sehen und spielen ldsst. Wir fangen mit einem Projekt an. Und wir spielen
auch schon mal ein bisschen mit einem Objekt herum.

In diesem Kapitel lernst du

© wie man Unity startet

© deine »Werkbank« kennen

© wie man Spiel-Objekte in einem Projekt einsetzt

© ein bisschen ber Spiele-Physik

© etwas liber 2D und 3D

© wie man die Position und GréBe von Objekten dndert

© wie man Unity beendet
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UNITY STARTEN

Bevor wir mit dem Basteln anfangen kénnen, muss das Game-Entwicklungssystem
Unity installiert werden. Wie das geht, erfahrst du in Anhang A. Wenn du dir das
Einrichten nicht allein zutraust, solltest du dir von jemandem helfen lassen.

Eine Mdglichkeit, Unity zu starten, ist diese:

> (ffne den Ordner, in den du Unity untergebracht hast (bei mir ist das der Unter-
ordner UNITY HUB im Ordner PROGRAMME auf Laufwerk C:).

[ | B 9 - | Unity Hub

Datei Start Freigeben Ansicht o
- - 1 « Program .. > Unity Hub ~ © 2 "Unity Hub" durchsuchen
~
icudtl.dat libEGL.dIl libGLESv2.  LICENSE.e  LICENSES.  natives_bl
dll lectron.txt  chromium ob.bin
.html
resources.  snapshot_ Uninstall Unity v8_contex
pak blob.bin Unity Hub.exe t_snapsho
Hub.exe t.bin Y
18 Elemente 1 Element ausgewahlt (93,1 MB) = =

Hier suchst du unter den vielen Symbolen eines von denen heraus, die wie eine Art
schwarzer Wiirfel aussehen, und zwar das mit dem Namen UNITY HUB.EXE.

> Starte das Programm mit einem Doppelklick auf das Symbol.

Ich empfehle dir, eine Verknlipfung auf dem Desktop anzulegen:

<> Dazu klickst du mit der rechten Maustaste auf das entsprechende Unity-
Symbol (Unity Hub.exe). Im Kontextmeni wihlst du KOPIEREN.

<> Dann klicke auf eine freie Stelle auf dem Desktop, ebenfalls mit der rechten
Maustaste. Im Kontextmenii wahlst du VERKNUPFUNG EINFUGEN.

< Esist sinnvoll, fiir das neue Symbol auf dem Desktop den Text unity hub.exe
- Verknupfung einfach durch Unity zu ersetzen.

Von nun an kannst du auf das neue Symbol doppelklicken und damit Unity
starten.



UNITY STARTEN

Je nach Computer kann es eine Weile dauern, bis Unity geladen ist. Einige Zeit spa-
ter landest du in einem neuen Fenster.

B unity Hub x
@l.mln.lI fx Hs
® Projects Projects ADD “
®  Leam

Installs O

You have no project here.

Click on New if you want to create one, Add if you want to add one to
your project list. Visit the Learn section if you prefer a wiorial to get
started.

You're using the latest version of the Unity Hub!

Startest du Unity zum allerersten Mal seit der Installation, dann musst du es Z7
wahrscheinlich noch aktivieren. Wenn du das nicht allein hinkriegst, schau mal
in Anhang A nach. Q

Dort hast du nun die Mdglichkeit, ein Projekt zu 6ffnen (wenn vorhanden). Oder
eines neu zu erstellen.

> Klicke auf NEw.

B Unity Hub

& unity & Hs

@ Projects Proj ects ADD m

> Im neuen Dialogfeld wahlst du die Einstellung 2D. Mit 3D beschéftigen wir uns
spater.

> Gib im Feld fiir PRoJECT NAME den Namen des neuen Projekts ein. Und dann bei
LocaTioN den Ordner, wo du dein Projekt unterbringen willst. (Wenn du alles so
stehen l3sst, schafft sich Unity seinen eigenen Ordner fiir deine Spiel-Projekte.)

Ich benutze einen Ordner UNITY und nenne mein erstes Projekt schlicht und Z7
einfach PROJEKT1. O
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B Create a new project with Unity
Templates Settings
® o ® Project Name
Projekt1
i > ¢
2D D 3D With Extras Locat
D:\Unity
® @ ) ’
—
—
CANCEL CREATE

> Klicke dann auf CREATE.

Und endlich zeigt uns Unity sein wahres Gesicht (was eine ganze Weile dauern
kann). Schauen wir uns erst einmal die Aufteilung der vier wichtigsten Fensterbe-
reiche an:

{ | % |l Elcenter| GiLocal | 14 b nfH % M & M Account = M Layers ~ M Layout -
i Scene | emGame | _ - _ _ i | 0 Inspector =i
a A Shaded w20 || @ |m &k |w| 0 fy |~ | K |Ww Gizmos | v | (o ul
v € SampleScene
Hierarchy: A e Inspector:
Liste aller Eigenschaften
Objekte der des aktuell
aktuellen ausgewahlten
Szene Objekts
M Project | @ Console | a ot
- | S ARAr 3T
¥ Favorites Assels
©, All Materials
4, All Models . . . o
A Project: Anzeige aller Dateien, die zum Projekt gehoren
e Console: Anzeige von Hinweisen und Fehlern
* m Packages
.

<> Im SCENE-Fenster sieht man erst einmal nur die Kamera. Fiir ein Spiel brauchen
wir dann noch mindestens ein weiteres Objekt wie eine Kugel oder eine Figur.
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<> Dabhinter liegt das GAME-Fenster: Hier siehst du dein Spiel in Echtzeit ablaufen,
wenn du es durch einen der dariiberliegenden Buttons gestartet hast.

< Im HIERARCHY-Fenster ist bis jetzt nur die MAIN CAMERA aufgelistet. Dort stehen
dann spéter alle Objekte, die zur Szene eines Spiels gehdren (jedes Spiel kénnte
also mehrere Szenen haben).

< Das PROJECT-Fenster erfasst die Ordner mit dem gesamten Zubehor fiir das ganze
Spiel. Dazu gehdren natiirlich u.a. auch Programmteile. Bilder, die du als Spiel-
objekt einsetzen willst (wie z.B. eine Kugel oder eine Figur) lassen sich einfach
mit der Maus aus einem Ordnerfenster unter Windows hier hineinziehen. Womit
die entsprechende Datei ins Projekt kopiert wird.

<> Dahinter findest du das CONSOLE-Fenster, das sich bei Fehlern meldet. AuBerdem
lassen sich dort Werte, z.B. von Spiel-Objekten, anzeigen.

< Um sich die Eigenschaften eines Objekts nicht nur anzuschauen, sondern auch
bearbeiten zu kdnnen, gibt es das INSPECTOR-Fenster.

> Klicke mal im HIERARCHY-Fenster auf MAIN CAMERA. Dann verédndert sich nicht nur
die Darstellung im SCENE-Fenster, sondern der INSPECTOR zeigt plotzlich eine
ganze Menge an (dndern solltest du allerdings daran nichts).

ux Standalone - Unity

File Edit Assets GameObject Component Window Help

I XIIEICen:edEQLocal[!‘:’.-H nim
= Hierarchy | & 1| # Scene | amGame
% Al Shaded w|20 || ® W et |w @0 Hy v | K |Ww| Gizmos | ¥ | Al

& N Account -ILayers = || Layout -I

i | @ Inspector a i

@ +  Main Camera Static =

¥ &) SampleScens .
Tag MainCame~ Layer Default «

| )Main Camera

= M Transform e =
¥ Wl Camera @ =
Clear Flags Solid Color -
Background I
Culling Mask Everything -
Projecticn Orthographic -
Size 5
Clipping Planes Near 0.3
Far 1000
¥ Main Camera Viewpart Rect
X0 Y 0
Wi H1
Depth =
Rendering Path Use Graphics Setlir =
M Project | B Console = Target Texture Mone (Render Text &
+- E it - B |*|=n Occlusion Culling
v *Qa:;:":‘teﬁau 285510 HDR Use Graphics Settir «

0, All Madels MSAA Off -

©, All Prefabs - Allow Dynamic Reso
Display 1 =

¥ @ Assets Target Display
I Scenes Scones Target Eye Mone (Main Display=
= I Packages .
Lo ~ Audio Listener a @

Add Componant
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Um das Hauptmenii und die darunterliegenden Symbole geht es erst mal nicht,
damit bekommen wir spater noch genug zu tun.

< Projekt - SampleScene - PC, Mac & Linux Standalone - Unity

File Edit Assets GameObject Component Window Help

' | ] ‘ ] | i ‘ i ‘ W ICemer| @ Local un E n Account 'ILayers -lLayeut -

EIN OBJEKT ZUM SPIELEN

Wir beginnen mit etwas Einfachem. Wir brauchen eine Kugel und die soll sich iiber
das Spielfeld bewegen lassen. Mit der Maus oder mit den Tasten zum Beispiel.

> Kommen wir zum Hauptmenii. Klicke dort auf GAMEOBJECT und dann auf den
Eintrag 3D OBJECT. Im Zusatzmeni bekommst du nun eine Auswabhl. Klicke auf
den Eintrag SPHERE (= Kugel).

GameObject Component Window Help

Create Empty Child Alt+Shift+N

3D Object > Cube
2D Object > Sphere
Effects > Capsule
Light > Cylinder
Audio > Plane
Video > Quad
ul ? Text - TextMeshPro
Camera
Ragdoll...
Center On Children .
Terrain
Make Parent Tren
Clear Parent Wind Zone
Set as first sibling Cirl+= 3D Text
Set as last sibling Ctrl+-
Move To View Ctrl+Alt+F
Align With View Ctrl+Shift+F
Align View to Selected
Toggle Active State Alt+Shift+A

Alternativ zum Hauptmeni l3sst sich ein solches Objekt auch direkt im HIERAR-

CHY-Fenster erstellen. Dazu 6ffnest du mit der rechten Maustaste ein Kontext-

meni, und tiber 3D OBJECT ein weiteres. Dort klickst du auf das gewiinschte
QO Objekt, wie z.B. SPHERE.
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Copy
Paste
Rename
Duplicate
Delete

Select Children
Select Prefab Root

Create Empty
3D Object

2D Object
Effects

Light

Audio

Video

Ul

Camera

Cube
Sphere
Capsule
Cylinder
Plane
Quad

Text - TextMeshPro
Ragdoll...
Terrain
Tree

Wind Zone
3D Text

AnschlieBend taucht im SCENE-Fenster etwas auf, das wie ein Kreis aussieht.
AuBerdem zeigt der INSPECTOR zahlreiche Informationen liber unser neues Spiel-

Objekt.

"= Hierarchy

+v Qar All

# Scene

v < Kugell
7] Main Camera
& Sphere

Shased | m | & W % |~ H0/% - % mee camos 1<

@ Inspector

8 ~ Sphere " Static v
v Tag Untagged v Layer Default =

» . Transform o 3t

» B  Sphere (Mesh Filter) o

v {5 v MeshRenderer o

» Materials

» Lighting

» Probes

 Additional Settings

> @ - Sphere Collider o

u Default-Material
> Shader Standard

Add Component

Dargestellt sind nun zwei Objekte: Die Kamera (auf die wir noch zu sprechen kom-

men) und darunter oder dahinter die von uns erzeugte Kugel.

Nun ist es an der Zeit, die ganze Szene schon einmal zu speichern.

> Klicke auf FILE und SAVE.
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File
New Scene Ctrl+N
Open Scene Ctrl+0O
Save Ctrl+S
Save As... Ctrl+Shift+S

New Project...
Open Project...
Save Project

Build Settings... Ctrl+Shift+B
Build And Run Ctrl+B
Exit

Bei Unity heiBt diese Szene zuerst SAMPLESCENE. Passt dir der Name nicht,

dann klicke auf SPEICHERN UNTER und gib im Dialogfeld einen Namen ein, z.B.

Kugell (wenn dir nichts Besseres einfallt). Die Kennung UNITY wird automatisch
Q angefiigt. Dann klicke auf SPEICHERN.

< Save Scene

« v 1 « Unity > Projektl > Assets » Scenes ~ O £ "Scenes" durchsuchen
Organisieren ~ Neuer Ordner SER 0
~
@ Arbeitsplatz
_# 3D-Objekte
=] Bilder SampleSc
I Desktop ene.unity
5 Dokumente
¥ Downloads
- WorkDisk (D)
Dateiname: | Kugel1| -
Dateityp: |unity (*.unity) w

~ Ordner ausblenden Speichern Abbrechen

Wenn du anschlieBend im PROJECT-Fenster auf ASSETS klickst, siehst du da den Ord-
ner SCENES, darin befindet sich das Symbol fiir die Szenen-Dateien.
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s Project = & Console S
o € k| HB1

+ - .\
¥  Favorites Assets > Scenes
©, All Materials

C, All Models
O, All Prefabs Q
(@ Assets
Bs Scenes SampleSc...

» Bm Packages

€] Assets/Scenes/Kugell.unity

Und nun schauen wir uns diese Szene einmal genauer an, und zwar in einem ande-

ren Fenster.

> Dazu klickst du auf den Reiter mit dem Text GAME (direkt rechts neben dem
SCENE-Reiter).

= Hierarchy & i | fit Scene layGame |4_—

+ = (oAl Display 1 ~ Free Aspect ~| Scale @— 1x
v <4 Kugell
[ Main Camera
() Sphere

Maximize On Play

s Project = E Console

Du landest im GAME-Fenster. Das hat sich bis jetzt hinter dem SCENE-Fenster ver-
steckt.

Hier kannst du sehen, wie dein Spiel in Aktion aussieht. Bis jetzt ist da noch alles
dunkel und es bewegt sich nichts. An der Dunkelheit kénnen wir sofort etwas

andern.

> Klicke im Hauptmenii auf GAMEOBJECT und dann auf LIGHT. Im Zusatzmenii klickst
du auf den Eintrag DIRECTIONAL LIGHT.
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GameObject Component Window Help

Create Empty Ctrl+Shift+N

Create Empty Child Alt+Shift+N

3D Object >

2D Object >

Effects >

Light > Directional Light
Audio > Point Light
Video > Spotlight

Ul > Area Light
Camera Reflection Probe
Center On Children Light Probe Group

Make Parent
Clear Parent

Set as first sibling Cirl+=
Set as last sibling Ctrl+-
Move To View Ctrl+Alt+F
Align With View Ctrl+Shift+F
Align View to Selected

Toggle Active State Alt+Shift+A

Kurz darauf siehst du deine Kugel in einem anderen Licht. Nur im GAME-Fenster?

‘= Hierarchy o Game
T C— T ~ scole @— 1 wamzoonpiay|
v < Kugell* H
() Main Camera
f{] Sphere
7 Directional Light

s Project

> Klick dich doch mal zuriick zum SCENE-Fenster.
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Dort gibt es auch eine Anderung, wie du sehen kannst. Das neue Spiel-Objekt wird
als Symbol aus Strahlen dargestellt.

= Hierarchy S
4+ Al
v < Kugell
) Main Camera
) Sphere
[7) Directional Light

Da haben wir nun eine Kugel, die sich sonnt. Aber sie soll sich bewegen. Doch wie
kriegen wir sie dazu? Zuerst einmal sollten wir diesem »Ding« physikalische Eigen-
schaften geben. Dass das Objekt aussieht wie eine Kugel, heiBt noch nicht, dass es
sich auch wie eine Kugel aus einem bestimmten Material verhalt.

> Markiere also im HIERARCHY-Fenster (links) den Eintrag SPHERE. Dann suche im
INSPECTOR-Fenster (rechts) nach einem Button mit der Aufschrift ADD COMPONENT
und klicke darauf.

= Hierarchy 2 i | Scene | omGame i | © Inspector | &
a: All 2 m i a All
- O i Gizmos |~ R A @ v Sphere Static v
v € Kugell* ; -
1 Mai Tag Untagged ~ Layer Default -
] Sphere
?: ,p. v ) Transform e 3t

Positon X 0 Y 0 Zo

Rotation X O YO0 Z0

Scale X1 1 Z1
» [ sphere (MeshFilter) 9 3
» B v MeshRenderer [
» @ v Sphere Collider 9 i
@ :

>

u Default-Material
Shader Standard

Add Component




